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Chapter 150 

Tests for Two 
Correlated 
Proportions 
(McNemar Test) 
Introduction 
McNemar’s test compares the proportions for two correlated dichotomous variables. These two variables may be 
two responses on a single individual or two responses from a matched pair (as in matched case-control studies).  

This procedure is similar to the Matched Case-Control procedure also available in PASS. It differs from that 
procedure in three basic ways: 

1.  The results may be calculated exactly by binomial enumeration using an unconditional formula rather 
than using conditional, normal approximations to the binomial. 

2.  It only deals with the case of a matched pair: one case and one control (the Matched Case-Control 
procedure lets you match several controls with each case). 

3.  It is based directly on the 2-by-2 contingency table. 

To fix these ideas, consider the following fictitious data concerning the relationship between smoking and lung 
cancer. Suppose that a sample of N = 100 cases of identical twins in which only one twin has lung cancer is 
selected for further study. The twin with lung cancer is the case. The other twin serves as the control. Each pair of 
twins is surveyed to determine if they smoke tobacco. The results are summarized in the following two-way table: 
 

 No Lung Cancer Twin (Control) 
Lung Cancer Twin (Case) Smokes = Yes Smokes = No 
Smokes = Yes 16 21 
Smokes = No 4 59 
 

There is a basic difference between this table and the more common two-way table. In the matched-paired case, 
the count represents the number of pairs, not the number of individuals. 

The investigator wishes to compare the proportion of cases that smoke with the proportion of controls that smoke. 
The proportion of controls who smoke is (16+4)/100 = 0.20. The proportion of cases who smoke is (16+21)/100 = 
0.37.  
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Dividing each of the entries in the table by N gives the proportions: 
 

 No Lung Cancer Twin (Control) 
Lung Cancer Twin (Case) Smokes = Yes Smokes = No  Total 
Smokes = Yes 0.16 0.21 0.37 
Smokes = No 0.04 0.59 0.63 
Total 0.20 0.80 0.63 
 

Symbolically, this table is represented as: 
 

 No Lung Cancer Twin (Control) 
Lung Cancer Twin (Case) Smokes = Yes Smokes = No Total 
Smokes = Yes P11 P10 Pt 
Smokes = No P01 P00 1-Pt 
Total Ps 1-Ps 1 
 

Formally, the hypothesis of interest is that Pt equals Ps. A little algebra shows that Pt = Ps is equivalent to P10 = 
P01, since P11 is common to both. Thus, the null hypothesis of McNemar’s test is P10 = P01 and the alternative 
is that they are unequal. The alternative hypothesis may be one-sided (such as P10>P01) or two-sided (P10≠
P01). 

The null hypothesis may also be stated in terms of the odds ratio as OR = 1. The odds ratio is computed differently 
in the matched pairs case. The formula is: 

01
10

P
P = OR  

Notice that the values of P11 and P00 are not used in these hypotheses. It turns out that their individual values are 
not needed, but their sum is. 

For this example, the odds ratio is computed as 21/4 = 5.25.  

Technical Details 
Consider the matched-pairs table again: 
 

 Controls 
Cases Yes No Total 
Yes P11 P10 Pt 
No P01 P00 1-Pt 
Total Ps 1-Ps 1 
 

Pairs with the same response from cases and controls (Yes-Yes and No-No) are called concordant pairs. Pairs 
with different responses (Yes-No and No-Yes) are call discordant pairs. McNemar’s test statistic is the estimated 
odds ratio:  

Mc =  P
P

10
01

 

The sample size problem thus reduces to a study of how many Yes-No’s and No-Yes’s are needed. Once this has 
been determined, the overall sample size is found be estimating the proportion of discordant pairs and inflating 
the sample size appropriately. 
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Some power analysis programs follow an approximate procedure. Since the McNemar statistic follows the 
binomial probability distribution for a fixed number of discordant pairs, they use formulas that use the normal 
approximation to the binomial and then adjust the sample size depending on the proportion of discordant pairs, 
PD=P10+P01. This is called the conditional procedure.  

One such approximate formula is given by Machin, Campbell, Fayers, and Pinol (1997). 
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where s is the number of sides to the test (one or two), OR P
P

=
10
01

, PD P P= +10 01, and alpha and beta are the 

usual error rate probabilities. 

However, Schork and Williams (1980) published a formula which provides the exact results for the unconditional 
case using binomial enumeration of all possible outcomes. This formulation is also available in PASS. 
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where  

PD = P10+P01 

D = P10-P01 

N is total of all four cells (N11+N12+N21+N22) 

r is the smallest integer for which 
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Difference or Odds Ratio 
The formula given above is parameterized in terms of the difference. This formula is also used when odds ratios 
are specified. The program simply converts the OR value into its corresponding D value. 

Discussion 
The binomial enumeration (exact) algorithm works for N < 2000. Above 2000, computing time goes up and the 
algorithm has numerical problems. PASS lets you select either the binomial enumeration (exact), or the 
approximate, solutions. We have found that the approximate solution tends to use a sample size that is about 10% 
less than the exact solution. 

Because of the lengthy computer time necessary to compute the exact answer when N > 1500, we suggest that you 
use the approximate formula to begin with and then revert to the exact formula when you are ready for your final 
results. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains the parameters associated with this test such as the proportions, sample sizes, alpha, and 
beta. This chapter covers two procedures, which have different options. This section documents options that are 
common to both procedures. Later, unique options for each procedure will be documented.   

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Odds Ratio, Difference, Sample Size, Alpha, and Power. Under most situations, you will select either 
Power or Sample Size. 

The program is set up to evaluate power directly. For the other parameters, a search is made using an iterative 
procedure until an appropriate value is found. Two solutions can often be found when searching for the Odds 
Ratio or the Difference. You may specify the region in which you want the solution to be searched for. For 
example, you may search for an odds ratio either above or below one. Also note that the parameter selected must 
match the procedure you are using. For example, if you are searching for the odds ratio, you must be in the odds 
ratio window. 

Note that the value selected here always appears as the vertical axis on the charts. 

Power Calculation 

Power Calculation Method 
Select the method to be used to calculate power. 

The choices are 

• Binomial Enumeration 
Power is computed using binomial enumeration of all possible outcomes when N ≤ Max N for Binomial 
Enumeration (otherwise, the normal approximation is used). Binomial enumeration of all outcomes is 
possible because of the discrete nature of the data. 

• Normal Approximation 
Approximate power is computed using the normal approximation to the binomial distribution. 

The binomial enumeration formulas require lengthy calculations for large values of N and may be very time 
consuming. They should not be used for N > 2000. 

The approximate formulas tend to underestimate the N necessary to achieve a certain power value by about 10%, 
so they should only be used when the calculation time gets very prohibitive or when N > 2000. 
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Max N for Binomial Enumeration 
Only shown when Power Calculation Method = “Binomial Enumeration” 

Below this value of N, power calculation formulas using binomial enumeration are used. Above this value of N, 
approximate formulas based on the normal approximation to the binomial are used. 

The binomial enumeration formulas require lengthy calculations for large values of N and may be very time 
consuming. They should not be used for N > 2000. 

The approximate formulas tend to underestimate the N necessary to achieve a certain power value by about 10%, 
so they should only be used when the calculation time gets very prohibitive or when N > 2000. 

Test 

Alternative Hypothesis 
Specify whether the test is one-sided or two-sided. A one-sided hypothesis uses an inequality as in P10 > P01 or 
Odds Ratio > 1. A two-sided hypothesis states that the proportions are not equal without specifying which is 
greater. If you do not have any special reason to do otherwise, you should use the two-sided option.  

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5. 

Alpha 
This option specifies one or more values for the probability of a type-I error (alpha). A type-I error occurs when a 
true null hypothesis is rejected.  

Sample Size 

N (Number of Pairs) 
Enter a value (or range of values) for the sample size, N, the number of pairs in the study. 

You may enter a range of values such as 100,200,300 or 200 to 400 by 50. 
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Effect Size 

Input Type 
Indicate what type of values to enter to specify the effect size. Regardless of the entry type chosen, the 
calculations are the same. This option is simply given for convenience in specifying the effect size. 

Difference (P10-P01) 
Only shown when Input Type = “Differences” 

The difference, P10-P01, is a popular parameter to specify because it comes directly from the alternative 
hypothesis that Pt not equal Ps. If Pt and Ps are not equal, the obvious question is, by how much? The answer is, 
by P10-P01 since Pt-Ps = (P11+P10)-(P11+P01) = P10-P01. Hence, this is a value that may easily be set.  

The range of values is between -1 and 1. You may enter a list of value list 0.1, 0.15, 0.2 or 0.05 to 0.20 by 0.05. 

Odds Ratio (P10/P01) 
Only shown when Input Type = “Odds Ratios” 

The odds ratio is a popular parameter to specify because of its simple interpretability and close relationship to the 
relative risk. An odds ratio of 2.0 means that the odds of the numerator variable is twice the odds of the 
denominator variable. Note that several values of P10 and P01 can yield the same odds ratio. For example, 0.2/0.1 
and 0.4/0.2 both have an odds ratio of 2.0, but are based on very different values of P10 and P01. Under the null 
hypothesis, the odds ratio is one. Only positive values are allowed. 

You may enter a list of values like 1.5,2.0,3.0 or 1.2 to 2.4 by 0.2. 

Proportion Discordant (P10+P01) 
This is the proportion of discordant pairs (P10 + P01). This value will be difficult to specify unless you have 
previous studies that give you some idea of what to expect. When you have no idea, Machin, Campbell, Fayers, 
and Pinol (1997) suggest the following strategy. Estimate values of Pt and Ps. Calculate the proportion of 
discordant pairs using the approximation 

( ) ( )PtPsPsPtPD −+−= 11  

This approximation assumes that the two responses are independent in each subject, which will usually not be 
true. However, it may be the only way of determining a ball park value for this parameter. 
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Example 1 – Calculating Power using Odds Ratios 
This example will show how to calculate the power of a retrospective study for several sample sizes and odds 
ratio values. Suppose that a matched case-control study is to be run in which the odds ratios might be 1.5, 2.5, or 
3.5; PD is 0.3, N = 50 to 300 by 50; alpha is 0.05; and power is to be calculated.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for Two Correlated Proportions (McNemar Test) procedure window by expanding 
Proportions, then Two Correlated Proportions, then clicking on Test (Inequality), and then clicking on Tests 
for Two Correlated Proportions (McNemar Test). You may make the appropriate entries as listed below or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Binomial Enumeration 
Max N for Binomial Enumeration ............ 1500 
Alternative Hypothesis ............................ Two-Sided 
Alpha ....................................................... 0.05 
N (Number of Pairs) ................................ 50 to 200 by 50 
Input Type ............................................... Odds Ratios 
Odds Ratio (P10/P01)............................. 1.5 2.0 2.5 
Proportion Discordant (P10+P01) .......... 0.3 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Two-Sided McNemar Test 
      Proportion   
 Pairs   Difference Odds Ratio Discordant   
Power* N P10 P01 P10-P01 P10/P01 P10+P01 Alpha 
0.07467 50 0.180 0.120 0.060 1.500 0.300 0.050 
0.14214 100 0.180 0.120 0.060 1.500 0.300 0.050 
0.22451 150 0.180 0.120 0.060 1.500 0.300 0.050 
0.29790 200 0.180 0.120 0.060 1.500 0.300 0.050 
0.17849 50 0.200 0.100 0.100 2.000 0.300 0.050 
0.37305 100 0.200 0.100 0.100 2.000 0.300 0.050 
0.56457 150 0.200 0.100 0.100 2.000 0.300 0.050 
0.70340 200 0.200 0.100 0.100 2.000 0.300 0.050 
0.29601 50 0.214 0.086 0.129 2.500 0.300 0.050 
0.59122 100 0.214 0.086 0.129 2.500 0.300 0.050 
0.80105 150 0.214 0.086 0.129 2.500 0.300 0.050 
0.90751 200 0.214 0.086 0.129 2.500 0.300 0.050 
 
* Power was computed using binomial enumeration of all possible outcomes. 
 
References 
Schork, M. and Williams, G. 1980. 'Number of Observations Required for the Comparison of Two Correlated 
   Proportions.' Communications in Statistics-Simula. Computa., B9(4), 349-357. 
Machin, D., Campbell, M., Fayers, P., and Pinol, A. 1997. Sample Size Tables for Clinical Studies, 2nd 
   Edition. Blackwell Science. Malden, MA. 
 

  

http://www.ncss.com/


PASS Sample Size Software NCSS.com   
Tests for Two Correlated Proportions (McNemar Test) 

150-8 
 © NCSS, LLC. All Rights Reserved. 

 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. It should be close to one. 
N is the number of pairs in the sample. 
P10 is the proportion of pairs in cell 1,2 of the 2x2 table. 
P01 is the proportion of pairs in cell 2,1 of the 2x2 table. 
Difference is the difference between proportions parameter under the alternative hypothesis. 
Odds Ratio is the value of this parameter under the alternative hypothesis. 
Proportion Discordant is the total of P10 and P01. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 
Summary Statements 
A sample size of 50 pairs achieves 7.467% power to detect an odds ratio of 1.500 using a 
two-sided McNemar test with a significance level of 0.050. The odds ratio is equivalent to a 
difference between two paired proportions of 0.060 which occurs when the proportion in cell 1,2 
is 0.180 and the proportion in cell 2,1 is 0.120. The proportion of discordant pairs is 0.300. 
 

This report shows the power for each of the scenarios.  

Plot Section 
 

      
 

These plots show the power versus the sample size for the three odds ratios. 
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Example 2 – Validation using Schork and Williams (1980) 
Schork and Williams (1980) page 354 present a table of sample sizes for various combinations of the other 
parameters. When the difference is 0.2, the proportion discordant is 0.7, the power is 80%, and the one-sided 
significance level is 0.025, the sample size is 144.  

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for Two Correlated Proportions (McNemar Test) procedure window by expanding 
Proportions, then Two Correlated Proportions, then clicking on Test (Inequality), and then clicking on Tests 
for Two Correlated Proportions (McNemar Test). You may make the appropriate entries as listed below or 
open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Power Calculation Method ...................... Binomial Enumeration 
Max N for Binomial Enumeration ............ 1500 
Alternative Hypothesis ............................ One-Sided 
Alpha ....................................................... 0.025 
N (Number of Pairs) ................................ 144 
Input Type ............................................... Differences 
Difference (P10-P01) .............................. 0.2 
Proportion Discordant (P10+P01) .......... 0.7 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Two-Sided McNemar Test 
      Proportion   
 Pairs   Difference Odds Ratio Discordant   
Power* N P10 P01 P10-P01 P10/P01 P10+P01 Alpha 
0.80092 144 0.450 0.250 0.200 1.800 0.700 0.025 
 
* Power was computed using binomial enumeration of all possible outcomes. 
 

PASS also finds the power to be about 80%. 
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Example 3 – Computing Sample Size for a 2x2 Cross-Over Design 
Julious (2010) indicates on page 167 that a 2x2 cross-over trial can be analyzed using McNemar’s test if the 
period effect is ignored. This example will show you how to estimate the sample size for a 2x2 cross-over trial 
based on McNemar’s test calculations. In example 10.1 on page 170, Julious (2010) calculates a required sample 
size of 190 to detect an odds ratio of 2 with 90% power at a significance level of 0.05 when the proportion 
discordant is 0.48. Note that Julious (2010) uses a slightly different asymptotic sample size formula (see page 
169) from that used by this procedure. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Tests for Two Correlated Proportions (McNemar Test) procedure window by expanding 
Proportions, then Two Correlated Proportions, then clicking on Test (Inequality), and then clicking on Tests 
for Two Correlated Proportions (McNemar Test). You may make the appropriate entries as listed below or 
open Example 3 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power Calculation Method ...................... Normal Approximation 
Alternative Hypothesis ............................ Two-Sided 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
Input Type ............................................... Odds Ratios 
Odds Ratio (P10/P01)............................. 2 
Proportion Discordant (P10+P01) .......... 0.48 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for a Two-Sided McNemar Test 
      Proportion   
 Pairs   Difference Odds Ratio Discordant   
Power* N P10 P01 P10-P01 P10/P01 P10+P01 Alpha 
0.90000 193 0.320 0.160 0.160 2.000 0.480 0.050 
 
* Power was computed using the normal approximation method. 
 

PASS finds the sample size to be 193. It’s not surprising that the sample size is slightly different from Julious 
(2010) because the calculation formulas are not exactly the same. 
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